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1 Problems Starting Up
 

Problems

Computer won’t start up, restart, or shut down

Computer won’t start up.

Try these solutions: 

m Make sure your computer is getting power. (p. 13)

m Force your computer to restart. (p. 12)

m Increase the memory available for system software. (p. 15)

m Make sure memory is installed correctly. (p. 20)

m Replace the computer’s backup battery. (p. 20)

Unusual sound occurs when you try to start up the computer.

Try these solutions: 

m Make sure external devices are properly connected and turned on. (p. 14)

m Make sure memory is installed correctly. (p. 20)

m Test and repair the hard disk directory. (p. 21)

Computer won’t restart.

Try these solutions: 

m Make sure your computer is getting power. (p. 13)

m Quit open applications. (p. 13)

m Make sure you’re using the correct disk as a startup disk. (p. 16)

m Resolve system extension conflicts. (p. 17)

m Force your computer to restart. (p. 12)

m Reset the PRAM. (p. 19)
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Computer won’t shut down.

Try this solution: 

m Force your computer to shut down. (p. 13)

Single icon appears in middle of screen

Icon with blinking question mark appears.

Try these solutions: 

m Make sure external devices are properly connected and turned on. (p. 14)

m Re-bless the System Folder. (p. 16)

m Resolve system extension conflicts. (p. 17)

m Reset the PRAM. (p. 19)

m Test and repair the hard disk directory. (p. 21)

m Reinstall system software. (p. 21)

Icon with X appears.

Try this solution: 

m Make sure you’re using the correct disk as a startup disk. (p. 16)

Computer beeps

Try these solutions: 

m One or two beeps:  Make sure memory is installed correctly. (p. 20)

m Three, four, or five beeps:  Contact an Apple-authorized service provider. See the service 
and support information that came with your computer.

Computer freezes

Computer freezes before “Welcome to Mac OS” appears.

Note:  Startup may take several minutes if you have more than 32 megabytes (MB) of RAM 
installed because of the time it takes to verify that the RAM is functioning properly.

Try these solutions: 

m Take notes. (p. 11)

m Make sure external devices are properly connected and turned on. (p. 14)

m Force your computer to restart. (p. 12)

m Test and repair the hard disk directory. (p. 21)
 



 

 

                                              
m Reinstall system software. (p. 21)

Computer freezes during startup or while you’re using your computer.

Try these solutions: 

m Take notes. (p. 11)

m Make sure external devices are properly connected and turned on. (p. 14)

m Force your computer to restart. (p. 12)

m Resolve system extension conflicts. (p. 17)

m Test and repair the hard disk directory. (p. 21)

m Reinstall system software. (p. 21)

Keyboard or mouse doesn’t work.

Try these solutions: 

m Make sure external devices are properly connected and turned on. (p. 14)

m Resolve system extension conflicts. (p. 17)

m Test and repair the hard disk directory. (p. 21)

m Reinstall system software. (p. 21)

Message appears

Message about system software appears.

Try these solutions: 

m Take notes. (p. 11)

m Make sure you’re using the correct disk as a startup disk. (p. 16)

m Reinstall system software. (p. 21)

“Not enough memory” message appears. 

Note:  These solutions are for system software memory problems. For problems with 
application memory, see “Problems With Applications, Documents, and Memory” on 
page 23.

Try these solutions: 

m Increase the memory available for system software. (p. 15)

m Check RAM disk settings in the Memory control panel. (p. 15)

m Resolve system extension conflicts. (p. 17)
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Disk corruption message appears on startup. 

Try these solutions: 

m Take notes. (p. 11)

m Check RAM disk settings in the Memory control panel. (p. 15)

Normal desktop doesn’t appear

Screen is dark.

Try these solutions: 

m Wake up your computer. (p. 11)

m Make sure your computer is getting power. (p. 13)

m Reset the PRAM. (p. 19)

No icons appear in windows, and pointer alternates between an arrow and a 
wristwatch.

Try this solution: 

m Reset the window display. (p. 16)

Empty flashing box appears.

Try these solutions: 

m Re-bless the System Folder. (p. 16)

m Test and repair the hard disk directory. (p. 21)

m Reinstall system software. (p. 21)

Large folder-shaped areas containing pictorial buttons appear.

Try this solution: 

m Make sure you’re using the correct disk as a startup disk. (p. 16)

Hard disk icon doesn’t appear on desktop

Try these solutions: 

m Restart the computer. (p. 12)

m Make sure external devices are properly connected and turned on. (p. 14)

m Test and repair the hard disk directory. (p. 21)

This is what a typical 
hard disk icon looks like.
 



 

 

 

Computer starts up from wrong disk

Try these solutions: 

m Make sure external devices are properly connected and turned on. (p. 14)

m Make sure you’re using the correct disk as a startup disk. (p. 16)

m Reset the PRAM. (p. 19)

m Test and repair the hard disk directory. (p. 21)

Solutions

Take notes.

If you see an error message or the screen freezes, you don’t have to take action immediately. 
First, note the following information:

m the error message and numbers (if any)

m what you were doing when the problem occurred

m the programs you were using

m software you have installed recently (especially items that have been added to the System 
Folder)

m clues on the screen—is a menu selected? What programs and document icons are open? 

m anything else that seems relevant

If you were typing text, write down any text still visible on the screen so that some of your 
work will be easy to replace.

If this doesn’t solve your problem, return to “Problems” on page 7.

Wake up your computer.

If your screen is dark, a screen saver program may have darkened your screen, or the 
computer may have “gone to sleep” (to save energy) because it was inactive. If the power 
button on the front of your computer is amber, your computer is asleep. Turn off the screen 
saver or wake up your computer by pressing any key or moving the mouse.

You may want to adjust the settings in the Energy Saver control panel to determine when 
your screen and computer go to sleep. See the information about the Energy Saver control 
panel in Mac OS Help (choose Help from the Finder’s Help menu).

If this doesn’t solve your problem, return to “Problems” on page 7. 
Problems Starting Up 11
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Restart the computer.

Often you can eliminate a problem simply by restarting your computer, which clears the 
computer’s memory. Always try restarting the proper way:
1 If you can, save any open documents before restarting.

2 Open the Special menu and choose Restart.
Note:  You can also press the power button (®) on your Apple USB keyboard or on the 
front of the computer.

A dialog box appears.
3 Click Restart.
If the computer freezes:  Try quitting open applications. See “Quit open applications.” on 
page 13.

Force your computer to restart. 

m If you are unable to restart your computer as described above, try pressing the 
Command (x) and Control keys simultaneously while also pressing the power 
button (®) on your Apple USB keyboard or on the front of the computer.

m Open the cover on the side of your computer and locate the Reset hole (it’s the upper 
hole on the right side, between the Ethernet and modem ports). Carefully insert the end 
of a large straightened paper clip into the hole and push gently. Do not use excessive 
force. Your computer should restart.

m If neither of the above suggestions work, unplug your computer. Wait at least 30 seconds, 
then reconnect the power plug and turn your computer on by pressing the power 
button (®) on your Apple USB keyboard or on the front of the computer.

If this doesn’t solve your problem, return to “Problems” on page 7. 

Shut down the computer.

Always try shutting down your computer the proper way:
1 Open the Special menu and choose Shut Down, or press the power button (®) on your 
Apple USB keyboard or on the front of the computer.

2 In the dialog box that appears, click Shut Down.
 



 

If the computer freezes:  Try quitting open applications. See the following section, “Quit 
Open Applications.”

Force your computer to shut down.

If you are unable to shut down your computer the normal way, unplug your computer. Wait 
at least 30 seconds before turning your computer back on again.

Quit open applications.

When you restart your computer, the computer tries to quit all open applications. Sometimes 
an application doesn’t get the message to quit and you have to quit the application yourself. 
Important  Before quitting an application, make sure you save any open documents.
m You can quit almost any application by choosing Quit from the File menu or pressing 
Command (x)-Q. 

m If this doesn’t work, you can sometimes force a program to quit by simultaneously 
pressing the keys Command (x), Option, and Esc. Then click Force Quit in the dialog box 
that appears.

Note:  Unsaved changes in your current documents will be lost.

Immediately save all open documents, quit all other open programs, and restart your 
computer.

If this doesn’t solve your problem, return to “Problems” on page 7. 

Make sure your computer is getting power.
m Check that the keyboard and mouse cables are properly connected. Unplug each cable, 

then reconnect them.

m Check that the power cord is plugged into a working outlet. If it’s plugged into a power 
strip, make sure the power strip is turned on. 

If this doesn’t solve your problem, return to “Problems” on page 7. 

Make sure the screen is properly adjusted.
m Check that the settings for brightness, contrast, and geometry are adjusted properly in 

the Monitors & Sound control panel.

If this doesn’t solve your problem, return to “Problems” on page 7. 
Problems Starting Up 13
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Make sure external devices are properly connected and 
turned on.
m Make sure connectors are plugged in all the way. Try unplugging connectors on all of the 

devices, then plugging them back in.

m If the device has a power cord, make sure the cord is plugged into a working electrical 
outlet. 

m Make sure the device is turned on.

m If you are connected to an Ethernet network:

m Check the settings in the AppleTalk control panel to make sure that Ethernet is 
selected. 

m Your computer may not start up because of heavy network traffic. Disconnect the 
Ethernet cable, then start up again. Reconnect the Ethernet cable after the computer 
starts up. (It’s okay to connect and disconnect an Ethernet cable while your computer 
is on.) 

For USB devices:

m Plug the device into another USB port on your computer or into the USB port on another 
device that is plugged into a power outlet (such as a self-powered hub).

m If the device is connected to a hub, try unplugging one or more devices from the hub. 

m If the device is connected to a self-powered hub (a hub that has a power cord), make sure 
the cord is plugged into a working electrical outlet.

m Unplug all USB devices from your computer except the Apple USB keyboard and Apple 
USB mouse. Plug one device in at a time to determine which device is the problem, then 
refer to the documentation that came with the device. Also see the information on 
connecting equipment in the online documentation that came with your computer.

m If you suspect a mouse problem, clean your Apple USB mouse as described in the online 
documentation that came with your computer. Then, plug the mouse into an open USB 
port on your computer. If the mouse works, then you may have a problem with the 
keyboard. If the mouse doesn’t work, borrow an Apple USB mouse from another 
computer and connect it to yours. If that solves the problem, you may need to repair your 
mouse. Consult an Apple-authorized service provider.

m If you suspect a keyboard problem, borrow an Apple USB keyboard from another 
computer and connect it to yours. If that solves the problem, you may need to repair your 
keyboard. Consult an Apple-authorized service provider.

For non-USB devices:

m Shut down your computer by pressing the power button (®) on your Apple USB 
keyboard or on the front of the computer. When a dialog box appears, click Shut Down. 
Make sure all external devices are properly connected, make sure connectors are plugged 
in all the way, and turn on the devices. Then restart your computer.
 



 

m If that doesn’t solve your problem, shut down your computer again. Turn off and 
disconnect all external equipment, except your keyboard and mouse. Then restart the 
computer. To determine which piece of equipment may be causing the problem, 
reconnect one device, start up your computer, and make sure the device is operating 
correctly. Then shut down the computer. Continue reconnecting devices one at a time, 
starting up, verifying the devices work, and shutting down until you determine which 
device is causing the problem. Then refer to the documentation that came with that 
device, as well as the information on connecting equipment in the online documentation 
that came with your computer.

If this doesn’t solve your problem, return to “Problems” on page 7. 

Check RAM disk settings in the Memory control panel.

If you’re using a RAM disk and you see a disk corruption message at startup, click Cancel to 
close the message. Check the RAM disk settings in the Memory control panel to make sure 
that you aren’t trying to create a RAM disk larger than the amount of free space on your hard 
disk.

If this doesn’t solve your problem, return to “Problems” on page 7. 

Increase the memory available for system software.

If you’re having trouble starting up your computer, there may not be enough memory to 
load all the system software extensions you’ve installed. Restart the computer, holding down 
the Shift key until you see the message “Extensions Disabled” in the “Welcome to Mac OS” 
box.

Then try the following:

m Turn on (or increase) virtual memory in the Memory control panel. Your computer will 
perform well with virtual memory set to no more than twice the amount of RAM in the 
computer; for best performance, limit virtual memory to 1.5 times the amount of RAM.

m Reduce the size of the disk cache in the Memory control panel.

m If you use a RAM disk, reduce its size or turn it off in the Memory control panel.

m Use the Extensions Manager control panel to turn off extensions you don’t need. (You can 
use the Extensions Manager to create different sets of extensions for special situations.)

You need to restart the computer for these changes to take effect. See Mac OS Help 
(available in the Help menu) for more information about using virtual memory, a RAM disk, 
and the Extensions Manager.

If the problem persists, try performing a clean installation of system software. See Chapter 5, 
“Reinstalling Your Computer’s Software.”
Problems Starting Up 15
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If none of these suggestions work, install additional memory, or RAM, in your computer. See 
the online documentation that came with your computer for instructions on how to do this.

If this doesn’t solve your problem, return to “Problems” on page 7. 

Reset the window display.

There may be a problem with the display of the windows. Restart the computer and hold 
down the Option key until the desktop icons appear. When the desktop appears, all windows 
will be closed.

If this doesn’t solve your problem, return to “Problems” on page 7. 

Re-bless the System Folder.

If your computer is not recognizing the system software, the System Folder may need to be 
“re-blessed.” This helps the computer recognize which System Folder to use.
1 Start up your computer from the software install CD.
See Chapter 3, “Starting Up From a CD.”
2 Open the System Folder.

3 Double-click the System suitcase.

4 After the System suitcase opens, close the suitcase and System Folder windows and restart 
your computer.
If this doesn’t work, then try the following:
1 Drag the System suitcase and Finder out of the System Folder.

2 Close the System Folder.

3 Put the System suitcase and Finder back into the System Folder. 
If this doesn’t solve your problem, return to “Problems” on page 7. 

Make sure you’re using the correct disk as a startup disk.

At least one disk drive must have system software on it from which the computer can start 
up. Most computers have an internal hard disk that is used as the startup disk. You can also 
use the software install CD to start up your computer. 

m Make sure the correct disk is selected in the Startup Disk control panel.
 



 

m If your computer is trying to start up from a CD that is not a startup CD (it has no system 
software on it), press the Open button on your CD-ROM drive, carefully pull out the tray, 
and remove the disc. Gently push the tray in and restart your computer.

Note:  If your computer started up from a CD, the disc will not be automatically ejected 
when you shut down. Restart the computer while pressing the Open button on the drive. 
The tray should open so you can remove the disc. If the tray won’t open, see the next 
section, “CD disc is jammed..”

CD disc is jammed.

If a CD disc is jammed, shut down your computer. Locate the small hole near the disc drive’s 
opening, and carefully insert the end of a large straightened paper clip. Push gently until the 
CD tray opens, then pull out the tray and remove the disc. Do not use excessive force. 

If this doesn’t solve your problem, return to “Problems” on page 7. 

Resolve system extension conflicts.

If your computer does not start up properly or behaves erratically, you may have an 
extension or control panel that is not compatible with another extension or control panel, or 
with an application or system software.

Verify the problem

To verify that you have a compatibility problem:
1 Start up your computer while holding down the Space bar.
This opens the Extensions Manager control panel. 
2 Release the Space bar when the Extensions Manager control panel opens.
Problems Starting Up 17



3 Notice the name of the currently selected set of extensions in the Selected Set pop-up menu 
so that you can return to it later if you want.

4 Open the Selected Set pop-up menu and choose the “Mac OS 8.1 base” set.
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This makes the computer start up using only the software installed at the factory.
5 Click the Continue button to continue startup.

6 When the computer is ready, try the same actions that caused the problem.
If the problem no longer occurs, you probably have one or more extensions or control 
panels that don’t work with Mac OS 8.1. Continue with the steps that follow in “Test 
Individual Extensions and Control Panels.”

Test individual extensions and control panels
1 Restart your computer while holding down the Space bar.

2 Release the Space bar when the Extensions Manager control panel opens.

3 Click the Duplicate Set button to create a new set. In the window that appears, type a name 
for the set (for example, “Test Set”) and click OK.

4 Turn off all the extensions in the new set by choosing All Off in the Edit menu.

5 Turn on the item you want to test by clicking its checkbox.

6 Click the Continue button to continue startup.

7 Try the same actions that caused the problem.
If the problem occurs again, the item is probably incompatible. Remove the item from the 
Extensions folder or turn the item off using the Extensions Manager.
8 Repeat steps 1 through 7 for each item you want to test.
If you find that a piece of software is incompatible, contact the manufacturer of the software 
to see if an updated version is available.

Tip:  A recently installed extension or control panel might be the problem. If you have a lot 
of extensions and control panels, you may want to “work by halves.” Turn on half the 
extensions and control panels and test for the problem. If the problem disappears, repeat the 
process turning on half of the remaining items. If the problem persists, repeat the process 
turning off half of the items that are turned on. Continue to work by halves like this until you 
locate the conflicting extensions or control panels.

If this doesn’t solve your problem, return to “Problems” on page 7. 
 



 

Reset the PRAM.

Your computer stores information in an area of memory called parameter RAM (PRAM). 
Resetting the PRAM replaces the information stored there with the default (original) settings. 
Important  Some system preferences are stored in PRAM. Third-party software programs 
may also store information in PRAM. When you reset the PRAM, some of these preferences 
are lost. Make sure you make a note of the settings before you reset PRAM.
Resetting PRAM may affect the settings in some of your control panels, including the 
following:

m Date & Time

m Memory (information lost includes RAM disk settings)

m Monitors & Sound

m Keyboard and Mouse (or Trackpad)

m AppleTalk (“Connect via” is set to the Ethernet port)

m Map

Note:  You may also have to restore modem settings in any communications software 
programs you are using.

Follow these steps to reset the PRAM:
1 Make sure the Caps Lock key is not engaged.

2 Restart your computer and immediately press and hold the Command (x), Option, P, and R 
keys.

3 Hold the keys down until you hear the startup sound a second time, then release the keys. 

4 If you had special settings in any control panels or applications, open those control panels or 
applications to restore the settings you want.

5 If you set preferences for a modem, open the communications software program you are 
using and restore any modem settings.

Important  Make sure you are using an Apple USB keyboard. This procedure may not work 
with some USB keyboards from manufacturers other than Apple.
If this doesn’t solve your problem, return to “Problems” on page 7. 
Problems Starting Up 19
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Make sure memory is installed correctly.

If you hear one or more beeps, there may be a problem with the memory in your computer. 
If you recently installed RAM in your computer, check the installation instructions in the 
online documentation that came with your computer to make sure it is properly installed. 
Make sure you’ve used the proper type of RAM for your computer.

If this doesn’t solve your problem, return to “Problems” on page 7. 

Replace the computer’s backup battery.

If you have intermittent problems starting up your computer and the date is reset, replace 
the battery. See the online documentation that came with your computer for instructions on 
how to do this.
Important  Batteries contain chemicals, some of which may be harmful to the environment. 
Please dispose of used batteries according to your local environmental guidelines.

Lithium 
(Li)
Replacing the battery may affect the settings in some of your control panels, including the 
following:

m Date & Time

m Memory (information lost includes RAM disk settings)

m Monitors & Sound

m Keyboard and Mouse (or Trackpad)

m AppleTalk (“Connect via” is set to the Ethernet port)

m Map

Make sure you make a note of the settings before you replace the battery. 

Note:  You may also have to restore modem settings in any communications software 
programs you are using.

If this doesn’t solve your problem, return to “Problems” on page 7. 
 



 

Test and repair the hard disk directory.

Follow the instructions in Chapter 4, “Testing and Repairing Your Hard Disk Directory.”

If this doesn’t solve your problem, return to “Problems” on page 7. 

Reinstall system software.

Follow the instructions in Chapter 5, “Reinstalling Your Computer’s Software.”

If this doesn’t solve your problem, return to “Problems” on page 7. 
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Where to Find Onscreen Help

Mac OS Help

Step-by-step instructions for using the Mac OS are available from Mac OS Help. 

Mac OS Info Center

The Mac OS Info Center contains information about your computer and the Mac OS, 
including troubleshooting information. 

To open the help system,
choose Help from the
Finder’s Help menu.

Click this button to see the
online user’s manual.

Click this button to see
troubleshooting information
and information on Apple’s

online support Web sites.

Double-click the Mac OS Info
Center icon on the desktop to

open the Info Center.
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2 Problems Using Your Computer
 

Problems With Applications, Documents, and Memory

Message appears saying there’s not enough memory.

All the memory in your Macintosh is in use by other application programs, system software, 
and system resources.

m Quit other open programs to free memory, then open the program you want to use.

Note:  Make sure you have quit other applications, not just closed their open documents. 
To quit an application, open the application menu at the far right of the menu bar and 
choose the application name to make the application active. Then open the File menu 
and choose Quit.

m Follow these steps to allocate more memory to the program:

1 Choose About This Computer from the Apple (K) menu. Take note of the number in 
the Largest Unused Block section. This number tells you how much memory is 
available to open programs.

2 Quit the program if it’s open, select its icon, and choose Get Info from the File menu. 
Take note of the numbers in the Minimum Size and Preferred Size boxes. 
23
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3 If the number in the Minimum Size box is larger than the largest unused block, not 
enough memory is available to use this program. To free memory, quit open programs 
or restart the computer. You can also type a smaller number in the Minimum Size box 
if you want to open the program using less memory. But some programs don’t work 
well if you assign them less memory.

4 If the number in the Preferred Size box is smaller than the largest unused block, you 
may need to assign more memory to the program. (A program may need more 
memory if you are working with complex documents.) Type a larger number in the 
Preferred Size box. (Try increasing the number in increments of 200.)

m Use the Memory control panel to reduce the size of the disk cache, remove or reduce the 
size of your RAM disk, or turn on virtual memory. For more information, use Mac OS Help 
(choose Help from the Finder’s Help menu).

Note:  If you have both virtual memory and a RAM disk turned on in the Memory control 
panel, don’t set both of them at or near their maximum values. Doing so can result in 
unpredictable or reduced performance by your computer. (A RAM disk uses random-
access memory, or RAM, as if it were a hard disk.)

m Turn off system extensions that you don’t need using the Extensions Manager control 
panel. See the information about the Extensions Manager control panel in Mac OS Help 
(choose Help from the Finder’s Help menu).

m If you have installed system software additions from the Apple Extras folder, you may want 
to remove them if you are not using them. (This software can decrease the amount of 
memory available for use by application programs.) To remove a system software 
addition, run the system software Installer. Follow the steps for a custom installation (one 
of the choices is to Add/Remove software). For more information, see Chapter 5, 
“Reinstalling Your Computer’s Software,” on page 53.

m If you frequently want to open more programs than memory allows, you may want to 
install more random-access memory (RAM). See the online documentation that came 
with your computer.

Computer freezes.

m Your computer may be trying to complete a task, but it’s taking so long that it seems that 
the screen has frozen. If you need to do something else instead, try simultaneously 
pressing the Command (x) key and the period key (.) to cancel the task the computer is 
working on.

m There may be a temporary software problem that can be fixed by restarting your 
computer. See “Restart the computer.” on page 12.

If the problem recurs, it may involve one or more of your application programs. See the next 
entry for additional suggestions.
 



 

Software quits unexpectedly.

The application program needs more memory, or there is a software problem.

m Write down what you were doing when the message appeared, and write down the text of 
the message. This information may help a technical support representative diagnose your 
problem if you later need to contact Apple or the manufacturer of the application 
program.

About the codes in error messages:  The number codes in error messages are used in 
software development. Sometimes they can help a technician narrow down the source of 
a problem.

m Restart your Macintosh. (See “Restart the computer.” on page 12.) Most software 
problems are temporary, and restarting the computer usually corrects the problem.

m Check for multiple System Folders on your startup disk, using the Find File command. If 
you have more than one System Folder, throw away the current System Folder. The 
System Folder that your computer is using has the Mac OS icon on it, which distinguishes 
it from any other System Folder.

Try re-blessing another System Folder so that your computer uses that one on startup 
(see “Re-bless the System Folder.” on page 16). If that doesn’t work, try reinstalling system 
software (see Chapter 5, “Reinstalling Your Computer’s Software,” on page 53.)

m Check for viruses on all your disks, using a virus-detection program. Eliminate any viruses 
the program finds.

m Use the program’s Get Info window to give it more memory. (Select the program’s icon 
and choose Get Info from the File menu.) See “Message appears saying there’s not 
enough memory.” on page 23.

m If the problem occurs when you are trying to print, there may not be enough memory for 
printing. Quit other open programs to free memory.

m If the problem only occurs in one application program, check for multiple copies of the 
program on your hard disk. Use the Get Info command to check the programs’ version 
numbers. Keep one copy of the latest version and throw away all other copies.
Problems Using Your Computer 25



26 Chapter 2
Also, try reinstalling the program from the original disks. If reinstalling doesn’t solve the 
problem, contact the manufacturer of the program to see if the program contains 
software errors or “bugs” and if it is compatible with the version of system software you’re 
using.

m Sometimes incompatible system extensions or control panels can cause system software 
problems. Restart while holding down the Shift key; this temporarily turns off all system 
extensions.

If your computer works normally after you do this, use the Extensions Manager control 
panel (in the Control Panels folder in the Apple [K] menu) to turn on extensions and 
control panels one at a time. Restart after you turn on each extension or control panel. 
This procedure should identify incompatible extensions and control panels. (If you just 
added new software to your computer, its system extension is the most probable cause of 
the problem.) See “Resolve system extension conflicts.” on page 17.

If your computer performs better when a particular extension or control panel is turned 
off, contact the software’s manufacturer for information or an upgrade.

m Reduce the number of active fonts in your system by moving fonts from the Fonts folder 
to another folder [such as “Fonts (Disabled)”]. Then restart your computer.

m If the problem recurs, you may need to reinstall system software. See Chapter 5, 
“Reinstalling Your Computer’s Software,” on page 53.

Application won’t open.

m The application program may already be open. Check the Application menu to see which 
programs are running.

m There may not be enough memory available to open the program. Quit any programs 
you’re not using and try again. If that doesn’t work, try restarting the computer. 

You can also use virtual memory to make more memory available to your programs. You 
turn on virtual memory in the Memory control panel. See the information about the 
Memory control panel in Mac OS Help (choose Help from the Finder’s Help menu).

m The program isn’t requesting as much memory as it needs. Use the program’s Get Info 
window to give it more memory. See “Message appears saying there’s not enough 
memory.” on page 23.

m The program may be damaged, or it may not be compatible with Power Macintosh 
technology. Check to make sure the software is PowerPC-compatible. (See the program’s 
documentation, or contact the manufacturer or vendor.) Make sure you install the 
software from a known good source (such as the original program disks).

m Check that the program is compatible with the version of system software that you are 
using. (See the program’s documentation, or contact the manufacturer or vendor.)

m You may need an updated version of the software. Contact the software manufacturer for 
more information.
 



 

Application won’t open because a file can’t be found.

Macintosh programs designed specifically for the PowerPC microprocessor (also called 
“native” applications) use special files called “shared libraries.” Any necessary shared libraries 
should be installed automatically when you install these special Macintosh programs.

Follow the directions that came with your program to reinstall it. If the shared library is still 
missing, contact the software program’s manufacturer for assistance.

Document won’t open, or application program can’t be found.

The document may have been created with a program that is not on your hard disk, or with a 
different version of the program.

m Try starting a program that you think might be able to open the document. Then choose 
Open from the program’s File menu to open the document. For more information, see 
the documentation that came with the program.

m Purchase and install the correct software to use the document, or find out if the creator of 
the document can convert it to a format that one of your programs can use.

m Rebuild your desktop. To rebuild the desktop, hold down the Command (x) and Option 
keys on the keyboard while you restart the computer. Hold down the keys until a dialog 
box appears asking if you want to rebuild the desktop. Click OK.

m Don’t try to open the files in your System Folder. Most of the files in your System Folder 
are used by your computer for internal purposes and are not intended to be opened.

m If the document is from a DOS or Windows computer, see “DOS or Windows document 
won’t open, or displays incorrectly.” on page 28.

Document can’t be saved.

m A CD-ROM disc is a read-only medium. This means that information can be read 
(retrieved) from it, but not written (stored) on it. You can save the changed information 
on a hard disk. 

“QuickDraw 3D could not be found” message appears.

m Make sure that the following files are in the Extensions folder, inside the System Folder:

m QuickDraw 3D

m QuickDraw 3D RAVE

m QuickDraw 3D Viewer

m QuickDraw 3D IR
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If the files are there and you still get the message, it means that you don’t have enough 
memory to run the application. You may be able to open the application if you try one or 
more of the following:

m Quit other open applications.

m Reduce the amount of memory allocated to the application:

1 Select the application’s icon in the Finder.

2 Choose Get Info from the File menu.

3 Type a lower number in the box for Preferred Size.

m Install more memory (RAM).

DOS or Windows document won’t open, or displays incorrectly.

If you can’t open a DOS or Windows document by double-clicking its icon, try one of the 
following:

m Open the document from within the program by choosing Open in the program’s File 
menu.

m Use the PC Exchange control panel (in the Control Panels folder in the Apple [K] menu) 
to specify which Macintosh program will open the document.

If a DOS document is displayed incorrectly, or you see strange codes or characters in the 
document, try one of the following:

m Your application program may have special procedures for opening and saving documents 
with different file formats. See the information that came with your program, or call the 
program’s publisher.

m Try opening the document in another program.

Note:  Some characters that can be displayed on the Macintosh are not accurately displayed 
on DOS computers. 

See information about working with DOS or Windows documents on your Macintosh in 
Mac OS Help (choose Help from the Finder’s Help menu).

Can’t throw away a file.

m The file may be locked. From the Finder, select the file’s icon, choose Get Info from the 
File menu, and click the Locked checkbox to remove the X. You can delete locked files 
that are in the Trash by holding down the Option key while you choose Empty Trash from 
the Special menu.

m An application program may be using the file. Close the file or quit the program.

m The file may be in a shared folder that can’t be changed. You can throw away the file by 
turning off file sharing temporarily (click Stop in the File Sharing control panel). Or you 
can select the shared folder, choose Sharing from the File menu, and uncheck the box 
labeled either “Can’t be moved, renamed, or deleted” or “Same as enclosing folder.”
 



 

Older Macintosh programs don’t work properly.

m Some older Macintosh programs are not completely compatible with Macintosh 
computers that have the PowerPC microprocessor or Mac OS 8.1. Contact the program’s 
publisher to see if an upgrade is available.

Window disappears.

m Another window may be covering the one you’re looking for. Move, resize, close, or hide 
windows until you see the one you want.

m The program the window is associated with may be hidden. Choose Show All from the 
Application menu and then click the window you want, or choose the program from the 
Application menu.

Can’t quit program opened from Launcher.

Some programs in the Learning section of the Launcher (when you press the Learning 
category button) are self-running demos. If you can’t get out of one of the programs or 
demos, try the following:

m Look again to see if you can find a Quit button or other quitting option.

m Hold down the Command (x) key on your keyboard and, while holding it down, press 
the period (.) key.

m While holding down the Command (x) key on your keyboard, press the Q key.

m Press the power button (®) on your Apple USB keyboard or on the front of your 
computer, then press Return to shut down the computer. 

m Restart your computer by holding down the Command (x) and Control keys while you 
press the power button (®) on your Apple USB keyboard or on the front of the 
computer.

Problems With Hard Disks, CDs, and Other Storage Media

Problems With Hard Disks

Only one document called “Where have all my files gone?” appears on the hard 
disk.

If no files appear on the hard disk except for a single document called “Where have all my 
files gone?”, you started up your computer from a CD with system software earlier than 
Mac OS 8.1. To see the contents of your disk, you must start up your computer from a disk 
with Mac OS 8.1 (or later). 
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Can’t mount Mac OS, DOS, or ProDOS partitions.

m Use PC Exchange to mount these partitions as individual volumes on the desktop.
(PC Exchange is a control panel that is part of system software.)

Note:  If the disk contains both Mac OS and DOS-format partitions, PC Exchange will 
recognize only the Mac OS partition. 

Can’t resize Mac OS, DOS, or ProDOS partitions.

m To resize or reformat multiple Mac OS, DOS, or ProDOS partitions, you need to use third-
party software designed for partitioning hard disks and removable media cartridges.

Problems With CD Drives and Discs

CD disc is jammed.

The normal way to remove a CD disc from your computer is to drag the disc’s icon on the 
desktop to the Trash. You can also select the disc’s icon and choose Eject from the Special 
menu. Removable discs are usually ejected when you shut down your computer.
Warning  Turn off your computer before you attempt to remove a jammed disc. If you 
don’t, you may damage the CD-ROM drive.
If a disc is jammed, shut down your computer. Locate the small hole in the middle of the 
CD-ROM disc drive tray, and carefully insert the end of a large straightened paper clip. Push 
gently until the disc is ejected. Do not use excessive force.

˙

Icon doesn’t appear on desktop.

m Make sure that the disc label is facing up and the disc is centered in the tray. 

m Make sure the tray is closed all the way.

m Try restarting your computer.

m Make sure that the Apple CD-ROM and Foreign File Access extensions are turned on in 
the Extensions Manager control panel. Then restart your computer.

Emergency ejection hole
 



 

m Try starting up your computer from the system software CD that came with your 
computer. Insert the CD and restart while holding down the C key. (See Chapter 3, 
“Starting Up From a CD,” on page 45.) If only the hard disk icon appears on the desktop, 
then there may be a hardware problem with your CD-ROM drive. If the CD-ROM disc icon 
appears above the hard disk icon, reinstall your CD-ROM software. The easiest way to do 
this is by reinstalling your system software. See Chapter 5, “Reinstalling Your Computer’s 
Software,” on page 53.

m The disc may use a format that the Macintosh cannot recognize. Ask the disc’s 
manufacturer for a disc that a Macintosh can recognize.

Disc is vibrating in the drive.

m Make sure the disc is centered in the tray.

m Some CD-ROM disc labels have artwork that is noticeably thicker on one side than the 
other and can cause the disc’s weight to be slightly off-center. This uneven distribution of 
weight coupled with the high rotation speed of your CD-ROM drive can cause some discs 
to wobble in the drive and make your computer vibrate. The vibration does not damage 
the CD-ROM disc or the computer and affects very few CD-ROM discs. If you can feel or 
hear that the CD-ROM disc is vibrating in the computer, you don’t need to do anything 
special; continue to use the CD-ROM disc as you normally would. 

Note:  If you use a CD-ROM disc with a removable (sticky) label, remove the label before 
inserting the disc.

Tray won’t open.

If a CD-ROM disc icon appears on your screen: 

m Select the disc icon and choose Put Away from the File menu, or drag the icon to the 
Trash.

Note:  You won’t lose information on the CD by dragging its icon to the Trash.

If the AppleCD Audio Player is active, choose Eject CD from the File menu or click the 
eject button in the AppleCD Audio Player controller.

If you see a message that a disc can’t be put away because it is being shared, turn file 
sharing off in the File Sharing control panel in the Control Panels folder, available in the 
Apple (K) menu.

If no CD-ROM disc icon appears on your screen: 

m Restart your computer. Immediately after you hear the startup sound, press the Open 
button on your CD-ROM drive.

m The signal to open the tray may not be reaching the computer. Manually remove the disc, 
as described in the online documentation that came with your computer.

If neither of these suggestions works, your CD-ROM drive may be damaged. Contact an 
Apple-authorized service provider or Apple for further assistance.
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Can’t eject disc.

m If file sharing is on and you are having trouble ejecting a disc, turn file sharing off in the 
File Sharing control panel in the Control Panels folder, available in the Apple (K) menu.

“This is not a Macintosh disk:  Do you want to initialize it?” message appears. 

m Make sure that the Foreign File Access extension is installed and turned on. Use the 
Extensions Manager control panel in the Control Panels folder in the Apple (K) menu to 
turn it on, then restart your computer.

m Make sure the CD-ROM software is installed. (The CD-ROM software is already installed 
on Macintosh computers that come with CD-ROM drives.) The easiest way to install 
CD-ROM software is by reinstalling your system software. (See Chapter 5, “Reinstalling 
Your Computer’s Software,” on page 53.) Restart your computer after reinstalling system 
software.

m The disc may use a format that the Macintosh cannot recognize. Ask the disc’s 
manufacturer for a disc that a Macintosh can recognize.

Computer ejects disc unexpectedly. 

m Make sure the disc is lying flat in the tray and the disc label is facing up. 
Important  If you’re using a small (8 cm) disc, make sure it’s centered within the tray’s 
inner ring and the computer is absolutely level. An improperly seated small disc in your 
computer may result in damage to the disc, the CD-ROM drive, or both.
m The disc may need to be cleaned. (See the online documentation that came with your 
computer.) If there are visible scratches on the shiny side of the disc, you may be able to 
remove them with a CD-ROM disc polishing kit (available from your audio CD dealer). If 
the scratches can’t be removed, you need to replace the disc.

m The disc may be damaged. Try another disc in the drive, and try the original disc in 
another drive. If the original drive reads other discs or if the original disc also doesn’t 
work in another drive, the disc is probably damaged. You need to replace it.

Problems Using ISO 9660 or High Sierra Discs

Files can’t be opened.

m Discs in the ISO 9660 and High Sierra disc formats have version numbers attached to file 
names. Some application programs need these version numbers in order to work with 
files. To make the version numbers available to programs on your computer, drag the 
CD-ROM disc icon to the Trash. When the tray opens, hold down the Option key and 
push the tray back in. Continue to hold down the Option key until the disc is mounted in 
the drive. The program you are using should now be able to locate file names on that 
CD-ROM disc.
 



 

m Make sure that the Foreign File Access, ISO 9660 File Access, and High Sierra File Access 
files are present in the Extensions folder in the System Folder on your hard disk. If these 
files are not present, reinstall your CD-ROM software. The easiest way to do this is by 
reinstalling your system software. See Chapter 5, “Reinstalling Your Computer’s Software,” 
on page 53.

Problems Using Photo CDs

Icon doesn’t appear on desktop.

m Reinstall the CD-ROM and QuickTime software. The easiest way to do this is by 
reinstalling your system software. See Chapter 5, “Reinstalling Your Computer’s Software,” 
on page 53.

Color icons for individual images don’t appear.

m Your computer may be low on memory. To view color icons, restart your computer and 
then reopen the Photos folder. See Mac OS Help (choose Help from the Finder’s Help 
menu).

Image is scrambled, colors are displayed incorrectly, or no image appears.

m The program you are using may not be designed to work with large (high-resolution) 
image files. You can open the image with another program or you can assign more 
memory to the program. See Mac OS Help (choose Help from the Finder’s Help menu).

System “freezes,” or “bomb” message appears.

m Restart your Macintosh. (If you need help restarting your computer, see Chapter 1, 
“Problems Starting Up.”) The program you are using may not be designed to work with 
large (high-resolution) image files. You can open the image with another program or you 
can assign more memory to the current program. See Mac OS Help (choose Help from 
the Finder’s Help menu).

Problems Playing Audio CDs

See “Problems With Sound and Video” on page 41.

Problems With USB Devices

Message appears saying the device can’t operate because it needs more 
power than is available.

m If the device has a power cord, make sure the cord is plugged into a working electrical 
outlet.

m Plug the USB cable from the USB device into a USB port on your computer or another 
USB device that is plugged into a power outlet. 
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m If the device is connected to a USB hub, do the following:

m If the hub has a power cord, make sure the cord is plugged into a working electrical 
outlet.

m Try unplugging one or more devices from the hub. 

Message appears saying a device may not provide all of its functions because 
it requires more power.

m If the device has a power cord, make sure the cord is plugged into a working electrical 
outlet.

m Plug the USB cable from the USB device into a USB port on your computer or another 
USB device that is plugged into a power outlet. 

m If the USB device is connected to a USB hub, try unplugging one or more devices from 
the hub. 

Message appears saying a device plugged into another device needs more 
power than is available and all ports on the second device have been disabled.

m If the device has a power cord, make sure the cord is plugged into a working electrical 
outlet.

m Plug the USB cable from the USB device into another USB port on your computer or 
another USB device that supplies power (such as a hub).

m If the device is connected to a USB hub, try unplugging one or more devices from the 
hub. 

The device isn’t working, but no message appears.

m Make sure the USB connectors are plugged in properly.

m If the device has a power cord, make sure the cord is plugged into a working electrical 
outlet and the device is turned on.

m Some USB devices, such as printers, need to warm up for a few minutes after you turn 
them on. For more information, see the documentation that came with your device.

m Make sure you’ve installed the necessary software to use the device.

USB devices use software called “drivers” that allow your computer to check the device 
when it’s connected to make sure it gets enough power and speed. Some software drivers 
are already available on your computer in the Mac OS. However, with some devices, you 
may need to install the software drivers. For more information, see the documentation 
that came with your USB device.

m If you suspect a mouse problem, clean your Apple USB mouse as described in the online 
documentation that came with your computer. Then, plug the mouse into an open USB 
port on your computer. If the mouse works, then you may have a problem with the 
keyboard. If the mouse doesn’t work, borrow an Apple USB mouse from another 
computer and connect it to yours. If that solves the problem, you may need to repair your 
mouse. Consult an Apple-authorized service provider.
 



 

m If you suspect a keyboard problem, borrow an Apple USB keyboard from another 
computer and connect it to yours. If that solves the problem, you may need to repair your 
keyboard. Consult an Apple-authorized service provider.

m Make sure the cables on your device are not damaged or frayed. If so, contact the 
manufacturer of the device or see the documentation that came with the device.

For more information

m To find out more about USB and your computer, see the online documentation that came 
with your computer. 

m To find out more about your USB device, see the documentation that came with the 
device.

Problems Printing

If you’re using a USB printer, see also “Problems With USB Devices” on page 33.

Note:  Also refer to the documentation that came with the printer.

m Check your printer settings in the Chooser (in the Apple [K] menu), making sure you 
have selected the correct printer. 

m Turn off the computer and printer and check the printer cable connections. 

m If none of these suggestions solves the problem, you may need to reinstall the printer 
software that came with your printer. Refer to the documentation that came with your 
printer. 

Can’t print, or error message appears.

m There may not be enough memory for printing. Try the following:

m Try quitting other open applications.

m Immediately after sending the Print command, quit the application you’re printing 
from to free memory for printing.

m Increase the amount of memory for the desktop printer icon; select it, choose Get Info 
from the File menu, and type a larger number in the Preferred Size box.

m Reduce the amount of memory used by the application you’re printing from.

m If your document uses lots of fonts, choose Page Setup from the File menu. Make sure 
you have selected “Unlimited Downloadable Fonts” under PostScript™ Options. If that 
doesn’t work, use fewer fonts in the document.

m If the document contains complex graphics, remove some of the detail from the 
images.

m Don’t use background printing.

m Make sure the printer is turned on. Some printers need to warm up for a few minutes 
after you turn them on.
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m The printer may be out of paper or may need attention. Check the printer status lights 
and any messages on your screen. 

m Open the desktop printer icon and check for status messages.

m Print a detailed report. (In the Print dialog box, select “Print detailed report” under Error 
Handling.)

m Reinstall your printer software.

m Check the settings in the application’s Page Setup dialog box. If there is a setting for 
“printer type,” make sure it is set to the type of printer you are using.

Performance and Other Problems

Performance decreases.

m If you notice a decrease in your computer’s speed and general performance after you 
install a control panel or system extension, the software may not be compatible either 
with Macintosh computers built with the PowerPC microprocessor or with other system 
extensions. See “Resolve system extension conflicts.” on page 17. You may also need 
updated software. Contact the software manufacturer for more information.

m Use the Memory control panel to turn off virtual memory. See the information about 
memory in Mac OS Help (choose Help from the Finder’s Help menu).

Note:  If you turn on both virtual memory and a RAM disk in the Memory control panel, 
don’t set both of them at or near their maximum values. Doing so can result in 
unpredictable or reduced performance by your computer. (A RAM disk uses random-
access memory, or RAM, as if it were a hard disk.)

m If you still do not notice an improvement, you may want to reinstall system software on 
your startup hard disk. See Chapter 5, “Reinstalling Your Computer’s Software,” on 
page 53.

m If you typically use several application programs at the same time, your computer’s 
performance will increase if you install more random-access memory (RAM). See the 
online documentation that came with your computer.

m Remove unused fonts from the Fonts folder in the System Folder.

m Test and repair the hard disk. See Chapter 4, “Testing and Repairing Your 
Hard Disk Directory,” on page 47.

Computer isn’t performing well.

If, after trying the tips in the previous section, your computer still isn’t performing as fast as 
you’d like, try these suggestions. Each one will make only a small difference in your 
computer’s speed, but if you try them all, you’ll notice the improvement.
 



 

m Open the Memory control panel in the Control Panels folder in the Apple (K) menu; 
then make these changes:

m In the Disk Cache section, increase the Cache Size slightly. (Because the amount of 
memory available for opening programs decreases as you increase the size of the 
cache, do not set the Cache Size too high.)

m In the Virtual Memory section, click Off if you haven’t already done so.

m Open the Keyboard control panel in the Control Panels folder; then make these changes:

m Set the Key Repeat Rate to Fast.

m Set the Delay Until Repeat to Short. 

m If you don’t need to see thousands or millions of colors on the screen, reduce the color 
depth. Open the Monitors & Sound control panel in the Control Panels folder; then select 
256 in the Color Depth section.

m Increase the speed of mouse tracking. Open the Mouse control panel in the Control 
Panels folder; then set Mouse Tracking to Fast.

m Make sure your computer is not calculating folder sizes. Choose View Options in the View 
menu. Make sure the checkbox next to “Calculate folder sizes” is not selected. 

Note:  “Calculate folder sizes” is only available when “as List” is selected in the View 
menu.

m Test and repair the hard disk. See Chapter 4, “Testing and Repairing Your 
Hard Disk Directory,” on page 47.

3D rendering doesn’t seem to be accelerated.

The performance advantage of any 3D accelerator depends on the type of scene being 
rendered. Some applications may show the benefits of acceleration more than others. 

Check the following items:

m Set your screen to a lower resolution (the lowest resolution is 640 x 480) and reduce the 
number of colors. The online documentation that came with your computer may provide 
additional information about the video modes (resolution and color depth) that support 
3D acceleration.

m Make sure that your application uses QuickDraw 3D. Some older 3D applications don’t 
use QuickDraw 3D for rendering, and cannot be accelerated.

m If the Control Strip is overlapping or touching the 3D window, hide the Control Strip or 
move the window.

m Some applications allow you to turn hardware acceleration on or off. Check your 
application’s documentation to be sure that hardware acceleration is turned on.

m Check that the following files are in the Extensions folder, which is in the System Folder:

m ATI 3D Accelerator

m ATI Graphics Driver
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m ATI Video Memory Manager

Note:  If these files are missing, you need to reinstall system software in order to have 
them on your computer.

m Turn off virtual memory. (Apple recommends turning off virtual memory whenever you 
use 3D applications.) Open the Memory control panel, click the Off button in the Virtual 
Memory section of the control panel, and restart your computer.

Right-angle bracket prompt (>) appears.

Your computer has tried to launch a “debugging” application (perhaps you inadvertently 
pressed the Command (x) and Power keys at the same time), but could not find one on 
your hard disk. Debugging applications are programs that software developers use to locate 
and fix problems in computer code. If you do not have a debugging application installed, 
your screen displays a right-angle bracket prompt (>). To return to the desktop or your 
application, type G and then press Return.

Clock doesn’t keep time accurately.

If your clock begins to keep time inaccurately, replace the battery. See the online 
documentation that came with your computer for instructions on how to do this.
Important  Batteries contain chemicals, some of which may be harmful to the environment. 
Please dispose of used batteries according to your local environmental guidelines.

Lithium 
(Li)
Icons look strange.

m There may be a problem with the information that the computer uses to keep track of 
files. To fix this problem, rebuild the desktop. Hold down the Command (x) and Option 
keys on the keyboard while you restart the computer.

m You may be using a file-compression program to save space on your hard disk. Some 
compression programs change the appearance of icons. 

Font file can’t be opened or moved. 

m The font file may be damaged. Replace the font in the Fonts folder (inside the System 
Folder).

Blinking icon appears in menu bar.

m A program needs attention. Open the menu and choose the program whose icon is 
blinking (it may have a diamond by its name). Respond to any messages on the screen. If 
it’s not clear what you should do, consult the documentation that came with the program.

m Open the Easy Access control panel (if it is installed on your computer) and check 
whether any of its features are turned on. 

Computer makes unusual sounds. 

m Select a different alert sound in the Monitors & Sound control panel.
 



 

m If the sounds are regular or melodic, they may be caused by interference from electrical 
equipment. Move the computer farther away from any such equipment. 

m If you hear one or more beeps, there may be a problem with the memory in your 
computer. If you recently installed RAM in your computer, check the installation 
instructions in the online documentation that came with your computer to make sure it is 
properly installed. Make sure you’ve used the proper type of RAM for your computer.

Problems With Networks and File Sharing

If you are having problems using the network or file sharing, try the following before 
attempting further solutions:

m Make sure the network is working by opening the Chooser and checking for the shared 
disks and printers you usually use. See if other computers on your network have access to 
network devices.

m Open the AppleTalk and TCP/IP control panels and make sure the settings are correct. See 
the topic on file sharing in Mac OS Help (choose Help from the Finder’s Help menu).

m Make sure that all the network software is installed. The Network and AppleShare 
extensions should be in the Extensions folder. If you want to use file sharing, the File 
Sharing control panel should be in the Control Panels folder, and the File Sharing 
extension should be in the Extensions folder. If any of these items is missing, reinstall the 
system software. See Chapter 5, “Reinstalling Your Computer’s Software,” on page 53.

m There may be a physical problem with a cable, connector, hub, or wall jack. Make sure 
network cables are connected properly. Try substituting equipment that you know is 
reliable. ( You can even try a different computer if one is available.)

Computer you want doesn’t appear in the Chooser. 

m Make sure the computer you’re trying to connect to is turned on.

m Make sure file sharing is active on the computer you’re trying to connect to. (That 
computer’s File Sharing control panel should say that file sharing is on.)

Shared disk you want to use is not available.

m You may already be connected to the shared disk. Check for its icon on your desktop.

m You may not have the access privileges you need to use the shared disk. Ask the network 
administrator or the owner of the shared item to give you access. See the information on 
file sharing in Mac OS Help (choose Help from the Finder’s Help menu).

Can’t see any files on remote computer.

m Make sure that files are being shared on the other computer. The File Sharing Monitor 
control panel on that computer lists the items being shared.
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m Make sure you have the access privileges you need to view the files. Ask the network 
administrator or the owner of the shared item to give you access. See the information on 
file sharing in Mac OS Help (choose Help from the Finder’s Help menu).

File sharing can’t be turned on. 

m Make sure AppleTalk is turned on in the Chooser.

m Make sure you have at least 400K of space available on your hard disk. 

m Some disk-formatting programs don’t work with file sharing. If you use such a program, 
contact the manufacturer or vendor for compatibility information. 

m There may be a problem with some of the information your computer uses to start up file 
sharing. Follow these steps in order until the problem is solved:

1 Open the File Sharing control panel and enter new information in the Network 
Identity section. Then try again to turn on file sharing. 

2 Remove the File Sharing folder from the Preferences folder (inside the System Folder). 
Then restart the computer and try to turn on file sharing. 

3 Reset the PRAM. See “Reset the PRAM.” on page 19.

4 Remove the Users & Groups Data File from the Preferences folder (inside the System 
Folder). Restart the computer.

5 Reinstall system software. See Chapter 5, “Reinstalling Your Computer’s Software,” on 
page 53.

Item can’t be shared. 

m Make sure you have at least 1 MB of space available on your hard disk. 

m Some removable storage devices can’t be shared. Check with the manufacturer or vendor 
of the device for more information.

m Some disk-formatting programs don’t work with file sharing. If you use such a program, 
check with the program’s manufacturer or vendor.

Can’t open a shared disk or folder.

m You may not have the access privileges needed to use the disk or folder. Ask the network 
administrator or the owner of the shared item to give you access.

m Check with the owner of the item to make sure you are entering your name exactly as the 
owner specified (including spaces and capitalization) and try again.

You can’t remember your Administration password.

m Erase your Administration password (along with all of your AppleTalk settings and 
configurations) by dragging the AppleTalk or TCP/IP Preferences file (inside the 
Preferences folder in your active System Folder) to the Trash. When you open the 
AppleTalk or TCP/IP control panel again, you must reenter all your settings.
 



 

Your computer can’t connect to devices outside its local network.

m Check that your router address is correct in the TCP/IP control panel.

Your computer can connect to hosts by IP address, but not by name.

m Check the settings in the TCP/IP control panel:

m Check that you have entered valid domain names in the Additional Search Domains 
box.

m If you have entered your local and administrative domain names, double-check to 
make sure they’re correct. 

m Check that the domain name server (DNS) you have selected is actually a DNS server 
and is operating properly.

m Check with your Internet service provider (ISP) or network administrator if you have 
questions about configuring the TCP/IP control panel.

Servers:  Your computer does not respond to a “ping.”

m Check that you have an application open on your computer that uses TCP/IP and can 
respond to a ping from another computer, and that the correct port is being pinged.

m Check that your TCP/IP configuration is correct.

m Check that the Use 802.3 checkbox isn’t selected in the TCP/IP control panel.

Problems With Sound and Video

Can’t hear any sound.

m If you have headphones connected to the computer, make sure they are firmly 
connected. Make sure the volume control on your headphones is not turned down too 
low.

m If you do not have headphones connected to the computer, make sure that nothing else 
is plugged into the computer’s sound output port (-).

m If you are using a CD-ROM disc over a network, you won’t be able to hear the audio 
portion.

m Make sure that the correct sound source is selected in the Monitors & Sound control 
panel or in the Sound Source module in the Control Strip.

m Make sure the volume is turned up in the Monitors & Sound control panel.

m Make sure the volume is turned up in the AppleCD Audio Player. With the program open, 
drag the volume control slider up, use the volume controls on your computer, or press 
the Up Arrow key on your keyboard.

m The CD may have been paused. Click the Play/Pause button in the AppleCD Audio Player.
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Audio stops playing when you double-click a CD-ROM disc icon.

m You can’t open data files on a CD-ROM disc and listen to audio tracks on it at the same 
time.

Audio CD begins playing automatically when inserted.

m Your computer is set to automatically begin playing audio CDs when they are inserted. To 
turn off this feature, use the QuickTime Settings control panel to change the automatic 
play setting.

Sound comes out of computer’s speakers even though headphones are 
plugged in.

m Plug your headphones into one of the headphone jacks (f) on the front of the 
computer.

Sound in headphones is odd.

m Your computer has  3D Surround Sound, which doesn’t work well through 
headphones. To turn it off, open the Monitors & Sound control panel and click the Sound 
icon. Click to remove the X from the Enabled checkbox.

Can’t record from audio CD.

m Check your computer’s sound input port to see if a microphone or other device is 
connected.

m You may need to reset the sound options in the Monitors & Sound control panel. See the 
information on sound in Mac OS Help (choose Help from the Finder’s Help menu).

Can’t record with microphone.

m If you’re using your monitor’s built-in microphone to record, use the Monitors & Sound 
control panel to mute the monitor’s speakers. In the same control panel, make sure that 
the sound input is set to the monitor’s built-in microphone.

m If you’re using an external microphone plugged into your computer, make sure your 
sound input source is set to External Microphone. Open the Monitors & Sound control 
panel, click the Sound icon, and choose External Microphone from the Sound Input pop-
up menu.

See the information about sound in Mac OS Help (choose Help from the Finder’s Help 
menu).

“QuickDraw 3D could not be found” message appears.

m Make sure that the following files are in the Extensions folder (inside the System Folder):

m QuickDraw 3D

m QuickDraw 3D RAVE

m QuickDraw 3D Viewer

m QuickDraw 3D IR
 



 

If the files are there and you still get the message, it means that you don’t have enough 
memory to run the application. You may be able to open the application if you try one or 
more of the following:

m Quit other open applications.

m Reduce the amount of memory allocated to the application. Follow these steps:

1 Select the application’s icon in the Finder.

2 Choose Get Info from the File menu.

3 Type a lower number in the box for Preferred Size.

m Install more memory (RAM). See the online documentation that came with your 
computer for instructions on how to do this.
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3 Starting Up From a CD
 

To test, repair, or initialize a hard disk, or to install or remove system software on a hard disk, 
you need to start up your computer from another disk. You can start up your computer using 
the software install CD-ROM disc.

Starting Up From the Software Install CD

Follow these steps to start up from the software install CD.
1 Turn on your computer if it’s not already running.

2 Press the Open button on your CD-ROM drive.

3 Carefully open the tray and place the software install CD in the tray with the disc label facing 
up.
Make sure the disc is lying flat in the tray.
4 Gently push the tray in.

5 Hold down the C key on your keyboard while you choose Restart from the Special menu and 
wait for the message “Welcome to Mac OS” to appear.
If this doesn’t work, restart the computer, make sure the CD is inserted, and hold down the 
Command, Option, Shift, and Delete keys (to temporarily disable the hard disk). Hold the 
keys down until the message “Welcome to Mac OS” appears.
6 When you see the screen that says “Mac OS” and the phrase “Starting Up,” release the C key.
In a few seconds the desktop appears. The CD’s icon appears at the top-right corner of the 
desktop (above your hard disk icon), and the Apple (K) menu does not contain the usual 
items.

Note:  The desktop pattern is different from the pattern you normally see, since your 
computer is now using the system software that’s on the CD. Your regular desktop pattern 
will reappear when you start up from your normal startup disk. 
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When You’re Done With the CD

When you start up your computer from a CD, the CD cannot be ejected in the usual way. 

To restart your computer from the hard disk and eject the CD:
1 Choose Restart from the Special menu.

2 Immediately after hearing the startup sound, press the eject button on the front of the 
CD-ROM drive.
Note:  You can also change the startup disk by opening the Startup Disk control panel and 
selecting the hard disk. Restart your computer. After startup, eject the CD by selecting its 
icon and choosing Put Away from the File menu (or by dragging its icon to the Trash).
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4 Testing and Repairing Your 

Hard Disk Directory
 

If you see a message reporting that a disk is “damaged” or unreadable, the directory on your 
hard disk may have become corrupted. The directory can be corrupted

m any time the computer is not shut down properly, using the Shut Down command

m when your computer freezes or crashes

Repairing Corrupted Data on Your Disk

Most data corruption can be fixed easily by using Disk First Aid. Disk First Aid is an 
application on the software install CD that came with your computer. 
1 Start up your computer from the software install CD.
See Chapter 3, “Starting Up From a CD,” on page 45.
2 Locate the Disk First Aid icon and double-click it to open the Disk First Aid program.
3 Click the icon of the disk you want to test. 
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Disk icons appear in a box at the top of the Disk First Aid window. 
4 Click Repair to begin testing and repairing the disk directory.
If Disk First Aid Cannot Correct the Problem

m Make sure you started up from the software install CD. See Chapter 3, “Starting Up From a 
CD,” on page 45.

m Try running Disk First Aid a second or third time. Sometimes repeating the process 
corrects the problem.

m Use the Drive Setup utility (typically located in the Utilities folder) to update the driver.

m Use another disk repair or recovery program. Sometimes another program will help you 
recover a corrupted disk. 

Note:  Before using software from a manufacturer other than Apple, see the 
documentation that came with the software or contact the software manufacturer to 
make sure the program is compatible with your computer and the version of Mac OS 
installed on your computer. Apple cannot guarantee the performance of software from 
manufacturers other than Apple.

m If you can’t repair the disk directory, the System suitcase file or other resources may be 
damaged. Perform a clean installation of system software (see Chapter 5, “Reinstalling 
Your Computer’s Software,” on page 53). If that doesn’t work, reinitialize the hard disk 
(see “Initializing a Hard Disk” on page 49).
 



 

Updating the Hard Disk Drivers
1 Start up your computer from the software install CD. (See Chapter 3, “Starting Up From a 
CD,” on page 45.)

2 Locate the Drive Setup icon and double-click it to open the Drive Setup program.
3 In the list of drives, click the disk you want to update.
4 From the Functions menu, choose Update Driver.
A message appears saying the new driver won’t be available until you restart your computer.
5 Restart your computer. (See “Restart the computer.” on page 12.)
Initializing a Hard Disk

The hard disk inside your computer was initialized (formatted for use) at the factory, so you 
should need to initialize it only if your hard disk is damaged and can’t be repaired with Disk 
First Aid (or another disk repair program). 

You can initialize your internal hard disk using a program called Drive Setup, which is on the 
software install CD that came with your computer.
Warning  Initializing a disk erases all information on the disk. Before initializing your 
disk, recover all the information you can and copy it to another disk or a network file 
server.
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1 Start up your computer from the software install CD. (See Chapter 3, “Starting Up From a 
CD,” on page 45.)

2 Locate the Drive Setup icon and double-click it to open the Drive Setup program.
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3 In the list of drives, select the disk you want to initialize.
4 Click Initialize.
If initialization fails, choose Initialization Options from the Functions menu to select the “Low 
level format” and “Zero all data” options. Then try initializing the disk again.

If initialization fails a second time, test your hard disk for damage, as described in “Testing 
Your Hard Disk for Physical Damage” on page 50. 

Mac OS Extended Format

Mac OS Extended format is a new method of formatting hard disks that allows for more 
efficient use of hard disk storage space. You can format your hard disk with Mac OS Extended 
format by performing a custom initialization of your hard disk. For instructions, see Drive 
Setup Help in the Help menu.

Testing Your Hard Disk for Physical Damage
Note:  Testing the disk can take two hours or more, depending on the size of your disk.
1 Start up your computer from the software install CD. (See Chapter 3, “Starting Up From a 
CD,” on page 45.)
 



2 Locate the Drive Setup icon and double-click it to open the Drive Setup program.
 

3 In the list of drives, click the disk you want to test.
4 From the Functions menu, choose Test Disk.

5 When a message tells you that the testing is complete, click Quit.
If the test reveals a problem, the hard disk may be damaged. Consult an Apple-authorized 
service provider for assistance.
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5 Reinstalling Your Computer’s Software
 

If you are having problems with the system software or applications that came with your 
computer, you can replace software in the following ways:

m reinstall system software—if you encounter system software problems or you want to add 
or remove system software components

m reinstall individual applications—if you inadvertently erased an application on your hard 
disk, are having problems with an application, or an application is damaged

m restore your hard disk with its original contents—if you want your computer to have its 
original system software, factory settings, and applications that came with the computer

Reinstalling System Software

The Mac OS Install application, located on the software install CD, lets you reinstall the 
Mac OS (or specific components of the Mac OS) on your computer. This CD also includes a 
Read Me document that describes how to reinstall custom system software settings and 
application software that came with your computer.

Before Installing System Software

Before you begin the installation, do the following:

m Customized preferences and settings:  If you have preferences or settings in control 
panels and individual applications, make a note of them so you can easily reset them if 
necessary, after you install system software.

Note:  If you are having problems with your computer, you may not be able to open any 
files with preferences or customized settings.
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m Software that runs in the background:  If you are using software that runs in the 
background, such as virus protection software or access control software, you may need 
to turn it off before you reinstall system software. For instructions, see the documentation 
that came with the software.
Important  It is highly recommended that you back up the data on your hard disk before 
installing system software.
Reinstalling Mac OS System Software

Note:  If something goes wrong, see “Problems During Installation” on page 60.
1 Start up from the software install CD-ROM disc. (See Chapter 3, “Starting Up From a CD,” on 
page 45.)

2 Double-click the Mac OS Install icon.
A Welcome dialog box describes the steps in the installation process. To learn more about 
each step, click the Help button (h) in the upper-right corner of the window.

Click to display more 
information about 
each step.
3 When you’re ready to begin, click Continue. 
 



 

The Select Destination dialog box appears.
If necessary,
use the pop-up menu

to choose another
destination disk.
If you want to perform a clean installation, skip to “Performing a Clean Installation” on 
page 58. Otherwise, continue with the following step.

Note:  A clean installation gives you a fresh start with system software. It is sometimes the 
best way to solve a persistent problem.
4 Choose the destination disk from the pop-up menu and click Select.
The following dialog box appears.
5 Proceed to the next section, “Selecting Which Software to Install.”
Selecting Which Software to Install

After selecting a disk, you need to decide between a standard or a custom installation. The 
standard installation installs all the software you need for your model of computer and is the 
best choice to solve system software problems. A custom installation lets you add or remove 
specific system software components.

Note:  Keep in mind that the more components you install, the more memory, or RAM, is 
used and the greater the potential for software conflicts. Install only the items you expect to 
use. 

Standard installation:  Click Reinstall. Proceed to “Standard Installation” on page 56.
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Custom installation:  Click Add/Remove. Proceed to “Custom Installation” on page 56.

Standard Installation
1 Follow the instructions on your screen until you see the Install Software window.
Note:  Your screen may look slightly different from the one pictured here. 
2 If you want to update the hard disk drivers and create an installation report, click Options. In 
the window that appears, click the appropriate checkboxes, then click OK.

3 Click Start.

4 When the installation has finished, restart your computer.
Custom Installation
1 In the window that appears, select the software to install, the software to remove, or both.

Select the software you
want to add or remove.
 



2 Open the pop-up menu next to each software product and choose an option.
 

m Customized Installation—lets you choose the components to install

m Customized Removal—lets you choose the components to remove

Note:  Recommended Installation installs the standard components.
3 All available components for the software product appear in a window.

4 Scroll through the list of components and click the checkbox next to each component you 
want to install or remove.

Select the components
you want to install or

remove.

To select all components 
or none, open this pop-up 
menu and select the 
appropriate option.
You can see and select individual items within each component by clicking the arrow to the 
left of the component, then clicking the item you want to install. For more information about 
each component listed, click the box with the letter “i” in it to the right of the component.
5 When you’re finished choosing components, click OK.

6 Repeat steps 2–4 for all the software products you want to install or remove.

7 If you want to update the hard disk drivers and create an installation report, click Options. In 
the window that appears, click the appropriate checkboxes, then click OK.

8 Click Start.
A window appears, showing the status of the installation or removal process.

If you see messages about problems with your hard disk, see “Problems During Installation” 
on page 60.
9 When a message appears saying that the installation process finished, click Quit to leave the 
program or click Continue to install or remove other software.
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Performing a Clean Installation

This section provides instructions for what is commonly called a “clean installation” of system 
software. Performing a clean installation is more complicated than a standard installation, but 
it is sometimes the best way to solve a persistent problem. A clean installation gives you a 
fresh start with system software.

When you install system software using a clean installation, the Installer creates a new System 
Folder on your hard disk. The old System Folder is renamed Previous System Folder. Since 
your computer has a new System Folder, after a clean installation you must reinstall custom 
fonts, extensions, and control panels that you’ve added to your system or that came with 
utility or application programs. You will also need to reset modem settings in 
communications software programs you are using.

Note:  Though application programs are not replaced or changed, some require system 
software components that are removed from the System Folder during a clean installation. 
You may need to reinstall these applications after you perform a clean installation.
1 Start up your computer from the software install CD-ROM disc. (See Chapter 3, “Starting Up 
From a CD,” on page 45.)

2 Open the Mac OS Install application.

3 In the Welcome box, click Continue.
The Select Destination dialog box appears.
To perform a
clean installation,

click Options.
 



4 Click Options.
 

5 Click the Perform Clean Installation checkbox so that it has a checkmark in it, then click OK.

6 Click Select and follow the instructions until you see the Install Software dialog box.

7 To install software other than the basic system, click Customize and follow the instructions in 
the section, “Custom Installation” on page 56.

8 Click Start to install the software.
A new System Folder is installed on your hard disk. (The old System Folder is renamed 
Previous System Folder.) 
9 Restart your computer from the hard disk.
If the problem is solved:  See the following section that describes how to reinstall your 
custom extensions, fonts, and control panels.

If the problem is not solved:  You can reinstall your custom extensions, fonts, and control 
panels; or you can restore the previous system. These options are described in the following 
sections.

Reinstalling Your Custom Extensions, Fonts, and Control Panels

After a clean installation, you need to reinstall any custom extensions, fonts, and control 
panels you were using. If you don’t have the original installation discs, you can drag items 
one at a time from the Previous System Folder to the new System Folder. It’s a good idea to 
restart your computer after you install each item, to see if that’s the item causing the 
problem. After you’re sure that you’ve copied all the items you want into the new System 
Folder, delete the Previous System Folder by dragging it to the Trash.
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If the Clean Installation Didn’t Solve the Problem

You may have a hardware problem. Consult an Apple-authorized service provider. 

You may want to revert to the Previous System Folder so that you do not have to reinstall 
your custom extensions, fonts, control panels, and other items not installed with Mac OS 8.1. 
To use the previous system again, follow the steps in this section.
1 Locate the currently active System Folder. It is distinguished by the Mac OS icon on it.

2 Open the System Folder and move the System suitcase into the Preferences folder. Close the 
System Folder.

3 Rename the System Folder “Clean System Folder.”

4 Rename the Previous System Folder (the one you wish to use again) “System Folder.”

5 Open the newly designated System Folder and double-click the System suitcase. Close the 
window that appears, then close the System Folder.

Warning  Reverting to the previous System Folder may not work. If it doesn’t, you’ll have 
to perform a clean installation again.
The Mac OS icon should appear on the new System Folder’s icon. If it doesn’t appear, repeat 
this step.
6 Restart your computer.

7 Drag the Clean System Folder to the Trash.
Problems During Installation

This section helps you solve problems you may encounter while installing your software.

You can’t start up the computer using the software install CD.

m Your computer may have located the system software on your hard disk before it located 
the system software on the CD. 

With the CD inserted, open the Startup Disk control panel and click the CD icon. Then 
restart the computer. 

Note:  After you install the software, you’ll need to reselect your hard disk as the startup 
disk. Open the Startup Disk control panel again and click the icon for your hard disk. 
Then restart your computer.
 



 

The files on your hard disk disappear when you start up from the CD.

m If no files appear on the hard disk except for a single document called “Where have all my 
files gone?”, you started up your computer from a CD with system software earlier than 
Mac OS 8.1. To see the contents of your disk, you must start up your computer from a disc 
with Mac OS 8.1 (or later). 

You can’t install or restore software.

m Make sure your computer started up from the software install CD. See Chapter 3, 
“Starting Up From a CD,” on page 45.

The Installer cannot repair your hard disk.

m If you see a message that the disk can’t be fixed because a file is open, quit all programs. If 
file sharing is on, turn it off. Then try installing again. 

m Use Disk First Aid or a third-party disk repair utility to see if it can repair the disk. 

Note:  Before using a disk utility from a manufacturer other than Apple, see the 
documentation that came with the software or contact the software manufacturer to 
make sure the program is compatible with your computer and the version of Mac OS 
installed on your computer. Apple cannot guarantee the performance of software from 
manufacturers other than Apple.

If you don’t have a third-party utility, or if that utility can’t repair the disk either, you may 
need to reinitialize the hard disk. See “Initializing a Hard Disk” on page 49. After you’ve 
reinitialized the disk, try installing the system software again. 

The Installer cannot update the hard disk driver.

m If you don’t have an Apple-brand hard disk, or if you’ve updated your Apple hard disk 
with a non-Apple disk utility, use that disk utility or the one supplied by the disk’s 
manufacturer to update the drivers on your system. Make sure to get the latest version of 
the utility. 

m Some hard disks must be reinitialized before you can update the driver. See “Initializing a 
Hard Disk” on page 49.

You see a message that there’s not enough memory to use the Installer.

m Make sure you are starting up the computer from the software install CD.

You see a message that the System file cannot be modified. 

m You may have virus-protection software installed that guards against modification of the 
System file. Make sure you are starting up the computer from the software install CD. 
Drag any virus-protection software out of the System Folder and try installing again. You 
can put the virus-protection software back after installation. 
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m The System and Finder files may be locked. To see if your System file or Finder file is 
locked, open the System Folder and select the System or Finder icon. Open the File menu 
and choose Get Info. To unlock the file, click the Locked checkbox to remove the 
checkmark.

m Try performing a clean installation of system software. See “Performing a Clean 
Installation” on page 58.

You see a message that the installation was not successful. 

m Make sure the software install CD is the startup disk, then try installing system software 
again. If the installation is still not successful, try performing a clean installation.

m Make sure the CD is clean. See the online documentation that came with your computer 
for information on cleaning CDs.

Responding to Messages About Your Hard Disk

The Mac OS 8.1 Installer checks the destination hard disk for errors before installing the 
software. Additionally, if your hard disk was formatted with an Apple disk utility program, the 
Installer updates the hard disk drivers with the latest version of the driver software. If your 
disk drives are formatted with a disk utility from another company, the drivers are not 
updated. You should use the third-party disk utility to update your hard disk before installing 
Mac OS 8.1.

Note:  Before using a disk utility from a manufacturer other than Apple, see the 
documentation that came with the software or contact the software manufacturer to make 
sure the program is compatible with your computer and the version of Mac OS installed on 
your computer. Apple cannot guarantee the performance of software from manufacturers 
other than Apple.

Reinstalling Individual Applications

If you’re having problems with an application or it was damaged or inadvertently erased, try 
reinstalling that application. If an application came with its own CD, see the software 
documentation or the Read Me document on that CD for instructions on how to reinstall 
that software. If not, see the Read Me document on the software install CD for instructions 
on how to reinstall that software.
Important  If you have preferences or settings for individual applications, make a note of 
them so you can easily reset them if necessary, after you install system software. If you are 
having problems with your computer, you may not be able to open any files with preferences 
or customized settings.
 



 

Restoring All Original Software

The Apple Software Restore application, located on the software restore CD, restores all your 
original software, including original system software, factory settings, and applications that 
came with your computer. This application gives you the option of erasing your hard disk 
before restoring the original software, or just replacing the original software (“Restore In 
Place”).

Before Restoring Your Software

Before you begin the restore process, do the following:

m Customized preferences and settings:  If you have preferences or settings in control 
panels and individual applications, make a note of them so you can easily reset them if 
necessary, after you install system software.

Note:  If you are having problems with your computer, you may not be able to open any 
files with preferences or customized settings.

m Software that runs in the background:  If you are using software that runs in the 
background, such as virus protection software or access control software, you may need 
to turn it off before you reinstall system software. For instructions, see the documentation 
that came with the software.
Important  It is highly recommended that you back up the data on your hard disk on an 
external storage device or network file server before restoring your system.
Restoring In Place

This procedure replaces only your original software (original system software, factory 
settings, and applications that came with your computer) with new copies from the CD, 
leaving everything else on your disk untouched.
1 Start up your computer from the software restore CD and open the Apple Software Restore 
application.

Important  Your preferences may be reset to their original factory defaults, and if you’ve 
already registered software, this procedure may modify that data.
For instructions, see Chapter 3, “Starting Up From a CD,” on page 45.
2 Click the OK button on the introductory screen.

3 If necessary, click Switch Disk to choose the disk on which you want to restore your 
software.

4 Click the checkbox next to “Restore In Place.”

5 Click Restore.

6 An onscreen message shows the status of the restore process.
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7 Click Quit when the process is complete.
64 Chapter 5
Erasing Your Hard Disk

This procedure completely erases the contents of your hard disk before restoring the original 
contents (original system software, factory settings, and applications that came with your 
computer). 
1 Start up your computer from the software restore CD and open the Apple Software Restore 
application.
For instructions, see Chapter 3, “Starting Up From a CD,” on page 45.
2 Click the OK button on the introductory screen.

3 If necessary, click Switch Disk to choose the disk on which you want to restore your 
software.

4 Click the checkbox next to “Erase your hard disk before restoring.”

5 If necessary, change the disk format you want from the Volume Format pop-up menu.
The recommended option is “Same as selected configuration” because it restores your hard 
disk to the Mac OS Extended format. This format provides more efficient storage, especially 
on large disks.
6 Click Restore.

7 Click OK.

8 An onscreen message shows the status of the erase and restore process.

9 Click Quit when the process is complete.
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6 Contacting Apple for Help
 

If this handbook has not helped you solve your computer’s problem, try getting information 
from Apple’s product support site on the World Wide Web. See the next section, “Obtaining 
Information via the World Wide Web.”

If you can’t find answers on the support Web site, or don’t have access to the Web, contact 
Apple for assistance. For information on how to contact the Apple Assistance Center, see the 
service and support card that came with your computer. Before you contact Apple, see the 
section, “Have This Information Available Before Calling.” 

Obtaining Information via the World Wide Web

Apple provides substantial information online for its customers. If you have access to the 
World Wide Web ( WWW ), you may want to check the information in the support area before 
you call Apple. Support information can be found at the following Uniform Resource Locator 
(URL):

m www.apple.com/support

At Apple’s support Web site, you’ll find

m Apple software updates

m Tech Info Library—a searchable database of easy-to-read articles

m Tech Exchange—a resource for product-specific information and support, including a 
discussion forum and the latest news
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66 Chapter 6
Have This Information Available Before Calling

Have the following information and software available when calling the Apple Assistance 
Center: 

m a description of the problem (for example, the computer freezes in only one application 
or at startup) 

m what you have tried to do already

m the type of computer

m the serial number of your computer

m the version of system software, third-party software, external devices, and so on 
(especially if the problem involves something you have added to the computer)

m the software install CD

Be in front of the computer when you call so you can take steps the technician suggests. 

Using the Apple System Profiler

If you are able to start up your computer, the Apple System Profiler provides information 
about your computer that will help you and the Apple Assistance Center troubleshoot your 
computer.

To open the Apple System Profiler: 
1 Choose Apple System Profiler from the Apple (K) menu.
A System Overview window appears.
2 Use the commands in the Select menu to get more specific information about the hardware 
and software used by your computer, or to go back to the System Overview window.
m To find out what the items in the Apple System Profiler window mean, choose Show 
Balloons from the Help menu. Then point to the item you want to know about.

m The Create Report command in the File menu lets you create a customized report of 
system software information. You can print this report by choosing the Print command 
from the File menu.
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then click the

Index button.
Index

A

Administration password, forgetting  40
Apple Assistance Center  65, 66
AppleCD Audio Player  31, 41
Apple Guide. See Mac OS Help
Apple System Profiler  66
application programs

clean installation and  58
compatibility issues with older Macintosh 

programs  29
Disk First Aid  47–48
Drive Setup program  49–51
problems with  23–29
quitting  13, 29
reinstalling individual applications  62
resetting PRAM and  19
restoring all original software  63–64

B

batteries
replacing clock battery  38
replacing computer’s backup battery  20

beep sound  8, 20, 39
blinking icon in menu bar  38
blinking question mark icon  8
bomb message  33
C

CD-ROM discs. See also software install CD; 
software restore CD

cleaning  32
ejecting  30, 32, 46
jammed  17, 30
problems with  30–33, 42
starting up from  17, 45–46, 60–61

CD-ROM drive  30–32
Chooser, computer doesn’t appear in  39
cleaning CD-ROM discs  32
clean installation of system software  58–60
clock problems  38
control panels. See also individual control 

panels
reinstalling after clean installation  59
replacing battery and  20
resetting PRAM and  19
resolving compatibility problems with  17–18

custom installation of system software  56–58

D

date, incorrect  20, 38
deleting files  28
desktop

CD-ROM icon doesn’t appear on  30–31
hard disk icon missing from  10
normal desktop doesn’t appear  10
rebuilding  27, 38

devices, troubleshooting  14–15, 33–35
disk corruption message  10, 15
Disk First Aid  47–48
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then click the

Index button.
disks. See CD-ROM discs; hard disk
documents. See also files

deleting  28
DOS  28
missing  27, 29, 61
problems with  27–28, 32–33
unlocking  28, 62
“Where have all my files gone” document  29
Windows  28

DOS documents  28
DOS partitions  30
drivers

updating hard disk drivers  49, 61
USB devices and  34

Drive Setup program
initializing hard disk with  49–50
testing hard disk with  50–51
updating hard disk drivers with  49

E

Easy Access control panel  38
ejecting CD-ROM discs  30, 32, 46
electrical interference  39
empty flashing box  10
Energy Saver control panel  11
erasing hard disk  64
error messages. See messages
Ethernet network, device problems and  14
extensions

disabling  15, 26
incompatible  17–18
not enough memory for  15–16
reinstalling after clean installation  59
testing  18
virtual memory and  15

Extensions Manager control panel  15, 17–18
external devices, troubleshooting  14–15, 33–35

F, G

files
deleting  28
DOS  28
Finder file  62
font file  38
locked files  28, 62
missing  27, 29, 61
problems with  27–28, 32–33
System file  61–62
unlocking  28, 62
“Where have all my files gone?” file  29
Windows  28

file sharing  28, 31, 32, 39–41
File Sharing control panel  28, 31, 32, 39, 40
Finder file  62
font file  38
fonts

reinstalling after clean installation  59
software problems and  26

forced quit (applications)  13
forced restart  12
forced shutdown  13
Foreign File Access  30
formatting disks  30, 50
frozen system

during shutdown  13
during startup  9
before “Welcome to Mac OS” appears  8–9
while restarting computer  12
while using computer  9, 24
while using Photo CDs  33

H

hard disk
computer starts up from wrong disk  11, 16
erasing with software restore CD  64
icon missing from desktop  10
initializing  49–50
Mac OS Extended format and  50
messages about  62
missing files on  27, 29, 61
problems with  29–30, 61, 62
repairing corrupted data on  47–48, 61
starting up from external hard disk  16
testing  50–51
updating drivers on  49, 61

headphones  41, 42
help

Apple Assistance Center  65, 66
Apple support Web site  22, 65
 



 

Mac OS Help  22
Mac OS Info Center  22

High Sierra CD-ROM discs  32–33

I, J

icons
blinking icon in menu bar  38
blinking question mark icon  8
CD-ROM icon doesn’t appear on desktop  

30–31, 33
hard disk icon missing  10
icon with X in center  8
incorrect appearance of  38
missing from windows  10

initializing hard disk  49–50
installing system software  53–64
Install Mac OS 8.1 alias  54
ISO 9660 CD-ROM discs  32–33

K

keyboard. See also USB devices
doesn’t work  9
resetting PRAM and  19
startup problems and  13
troubleshooting USB devices and  14, 35

Keyboard control panel  37
keyboard shortcuts

canceling current operation  24
forcing application to quit  13
forcing computer to restart  12
quitting application  13, 29
rebuilding desktop  27, 38
resetting PRAM  19
restarting computer  12

L

Launcher  29
locked files  28, 62

M

Mac OS Extended format  50
Mac OS Help  22
Mac OS Info Center  22
Mac OS partitions  30
Mac OS system software. See system software
memory

disk corruption message and  10, 15
incorrectly installed  20
increasing for system software  15–16
“Not enough memory” message  9, 23–24, 61
problems with  23–29
QuickDraw 3D and  42–43
RAM disk  15, 24
resetting PRAM  19
restarting computer to clear memory  12
virtual memory  15, 24, 36, 38

Memory control panel
increasing memory for system software  15
insufficient memory and  24
performance and  36, 37, 38

menu bar, blinking icon in  38
messages

bomb message  33
disk corruption message  10, 15
during system software installation  61–62
messages about hard disk  62
messages while printing  35–36
“Not enough memory” message  9, 23–24
number codes in  25
“QuickDraw 3D could not be found” message  

27–28, 42–43
“This is not a Macintosh disk: Do you want to 

initialize it?” message  32
USB device messages  33–34

microphone  42
modem settings  19, 20
Monitors & Sound control panel  37, 41, 42
mouse. See also USB devices

doesn’t work  9
startup problems and  13
troubleshooting USB devices and  14, 34

Mouse control panel  37

N, O

network problems  14, 39–41
non-USB devices  14–15
“Not enough memory” message  9, 23–24
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P

parameter RAM. See PRAM
password, Administration  40
PC Exchange control panel  28, 30
performance problems  36–39
Photo CDs  33
ping, server doesn’t respond to  41
power, insufficient  33–34
power button

restarting computer with  12
shutting down computer with  12
sleep and  11

power cord  13, 14, 33–34
PRAM, resetting  19
preferences

reinstalling applications and  62
restoring original software and  63

printing problems  35–36
problems. See troubleshooting
ProDOS partitions  30
programs. See application programs
Put Away command  31, 46

Q

question mark icon  8
“QuickDraw 3D could not be found” message  

27–28, 42–43
QuickTime Settings control panel  42
quitting application programs  13, 29

R

RAM. See memory
RAM disk  15, 24
re-blessing System Folder  16
rebuilding desktop  27, 38
recording from audio CDs  42
reinstalling individual applications  62
reinstalling system software  53–64
removing system software  57
repairing hard disk  47–48, 61
Reset hole, forcing restart with  12
resetting PRAM  19
restarting computer
forced restart  12
keyboard shortcut for  12
problems restarting computer  7
procedure for  12
restarting to solve problems  12

restoring all original software  63–64
right-angle prompt appears  38

S

screen  8, 11, 13, 37
servers  41
shortcuts. See keyboard shortcuts
shutting down computer  8, 12–13
sleep  11
software install CD

problems starting up from  60
reinstalling system software with  53–62
starting up from  45–46

software restore CD
erasing hard disk with  64
restoring all original software with  63–64

software updates  65
sound

computer beeps  8, 20, 39
computer makes unusual sounds  7, 38–39
problems with  41–43

Sound Source module  41
speakers  42
standard installation of system software  56
starting up computer

from CD-ROM disc  17, 45–46, 60–61
computer freezing during startup  9
computer starts up from wrong disk  11, 

16–17
disk corruption message appears during  10
problems starting up computer  7–22, 60
unusual sound when starting up computer  7

Startup Disk control panel  46, 60
System file  61–62
System Folder

clean installation and  58, 59
multiple System Folders  25
re-blessing 16
 



 

system software
memory problems  9, 15–16
message about  9
not recognized by computer  16
reinstalling  53–64
removing  57
updates for  65

System suitcase file, damaged  48

T

TCP/IP control panel  40, 41
Tech Exchange  65
Tech Info Library  65
testing extensions and control panels  18
testing hard disk  50–51
3D accelerator  37–38
3D Surround Sound  42
troubleshooting. See also specific problems

Apple Assistance Center and  65, 66
Apple support Web site  22, 65
Apple System Profiler and  66
application programs  23–29
computer beeps  8, 20, 39
external devices  14–15, 33–35
frozen system  8–9, 12, 13, 24
hard disk  29–30, 61, 62
jammed CD-ROM discs  17, 30
keyboard  9, 14
Mac OS Help and  22
Mac OS Info Center and  22
memory problems  9, 20, 23–29, 61
mouse  9, 13, 14, 34
printing problems  35–36
problems during system software installation  

60–62
problems using computer  23–43
reinstalling system software and  53–64
screen  8, 11, 13, 37
sound problems  41–43
startup problems  7–22, 60
unusual sounds  7, 38–39
USB devices  14, 33–35
video problems  41–43

turning off computer  8, 12–13
U

unlocking files  28, 62
USB devices  14, 33–35. See also keyboard; 

mouse

V

video problems  41–43
virtual memory  15, 24, 36, 38
virus-protection software  25, 54, 61, 63

W, X, Y, Z

waking up computer  11
Web sites, Apple  22, 65
“Where have all my files gone?” document  29
windows

disappearing  29
no icons appear in  10
resetting window display  16

Windows documents  28
World Wide Web ( WWW )

Apple support information on  64, 65
Mac OS Info Center and  22
Index 71




	Emergency Handbook Includes troubleshooting, hard disk repair, and software installation information for your iMac
	Contents
	1 Problems Starting Up����7
	Problems����7
	Computer won’t start up, restart, or shut down����7
	Single icon appears in middle of screen����8
	Computer beeps����8
	Computer freezes����8
	Message appears����9
	Normal desktop doesn’t appear����10
	Hard disk icon doesn’t appear on desktop����10
	Computer starts up from wrong disk����11
	Solutions����11
	Take notes.����11
	Wake up your computer.����11
	Restart the computer.����12
	Force your computer to restart.����12

	Shut down the computer.����12
	Force your computer to shut down.����13

	Quit open applications.����13
	Make sure your computer is getting power.����13
	Make sure the screen is properly adjusted.����13
	Make sure external devices are properly connected and turned on.����14
	Check RAM disk settings in the Memory control panel.����15
	Increase the memory available for system software.����15
	Reset the window display.����16
	Re-bless the System Folder.����16
	Make sure you’re using the correct disk as a startup disk.����16
	CD disc is jammed.����17

	Resolve system extension conflicts.����17
	Reset the PRAM.����19
	Make sure memory is installed correctly.����20
	Replace the computer’s backup battery.����20
	Test and repair the hard disk directory.����21
	Reinstall system software.����21
	Where to Find Onscreen Help����22
	Mac�OS Help����22
	Mac�OS Info Center����22


	2 Problems Using Your Computer����23
	Problems With Applications, Documents, and Memory����23
	Problems With Hard Disks, CDs, and Other Storage Media����29
	Problems With Hard Disks����29
	Problems With CD Drives and Discs����30
	Problems Using ISO 9660 or High Sierra Discs����32
	Problems Using Photo CDs����33
	Problems Playing Audio CDs����33

	Problems With USB Devices����33
	Problems Printing����35
	Performance and Other Problems����36
	Problems With Networks and File Sharing����39
	Problems With Sound and Video����41

	3 Starting Up From a CD����45
	Starting Up From the Software Install CD����45

	4 Testing and Repairing Your Hard�Disk�Directory����47
	Repairing Corrupted Data on Your Disk����47
	If Disk First Aid Cannot Correct the Problem����48

	Updating the Hard Disk Drivers����49
	Initializing a Hard Disk����49
	Mac�OS Extended Format����50

	Testing Your Hard Disk for Physical Damage����50

	5 Reinstalling Your Computer’s Software����53
	Reinstalling System Software����53
	Before Installing System Software����53
	Reinstalling Mac OS System Software����54
	Selecting Which Software to Install����55

	Performing a Clean Installation����58
	Reinstalling Your Custom Extensions, Fonts, and Control Panels����59
	If the Clean Installation Didn’t Solve the Problem����60

	Problems During Installation����60
	Responding to Messages About Your Hard Disk����62

	Reinstalling Individual Applications����62
	Restoring All Original Software����63
	Before Restoring Your Software����63
	Restoring In Place����63
	Erasing Your Hard Disk����64


	6 Contacting Apple for Help����65
	Obtaining Information via the World Wide Web����65
	Have This Information Available Before Calling����66
	Using the Apple System Profiler����66


	Index����67

	Problems Starting Up
	Problems
	Computer won’t start up, restart, or shut down
	Single icon appears in middle of screen
	Computer beeps
	Computer freezes
	Message appears
	Normal desktop doesn’t appear
	Hard disk icon doesn’t appear on desktop
	Computer starts up from wrong disk
	Solutions
	Take notes.
	Wake up your computer.
	Restart the computer.
	Force your computer to restart.

	Shut down the computer.
	Force your computer to shut down.

	Quit open applications.
	Make sure your computer is getting power.
	Make sure the screen is properly adjusted.
	Make sure external devices are properly connected and turned on.
	Check RAM disk settings in the Memory control panel.
	Increase the memory available for system software.
	Reset the window display.
	Re-bless the System Folder.
	Make sure you’re using the correct disk as a startup disk.
	CD disc is jammed.

	Resolve system extension conflicts.
	Reset the PRAM.
	Make sure memory is installed correctly.
	Replace the computer’s backup battery.
	Test and repair the hard disk directory.
	Reinstall system software.
	Where to Find Onscreen Help
	Mac�OS Help
	Mac�OS Info Center


	Problems Using Your Computer
	Problems With Applications, Documents, and Memory
	Problems With Hard Disks, CDs, and Other Storage Media
	Problems With Hard Disks
	Problems With CD Drives and Discs
	Problems Using ISO 9660 or High Sierra Discs
	Problems Using Photo CDs
	Problems Playing Audio CDs

	Problems With USB Devices
	Problems Printing
	Performance and Other Problems
	Problems With Networks and File Sharing
	Problems With Sound and Video

	Starting Up From a CD
	Starting Up From the Software Install CD
	When You’re Done With the CD


	Testing and Repairing Your Hard�Disk�Directory
	Repairing Corrupted Data on Your Disk
	If Disk First Aid Cannot Correct the Problem

	Updating the Hard Disk Drivers
	Initializing a Hard Disk
	Mac�OS Extended Format

	Testing Your Hard Disk for Physical Damage

	Reinstalling Your Computer’s Software
	Reinstalling System Software
	Before Installing System Software
	Reinstalling Mac OS System Software
	Selecting Which Software to Install
	Standard Installation
	Custom Installation


	Performing a Clean Installation
	Reinstalling Your Custom Extensions, Fonts, and Control Panels
	If the Clean Installation Didn’t Solve the Problem

	Problems During Installation
	Responding to Messages About Your Hard Disk

	Reinstalling Individual Applications
	Restoring All Original Software
	Before Restoring Your Software
	Restoring In Place
	Erasing Your Hard Disk


	Contacting Apple for Help
	Obtaining Information via the World Wide Web
	Have This Information Available Before Calling
	Using the Apple System Profiler


	Index


